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FOREWORD

The Computational Fluid Dynamics (CFD) computer codes and Knowledge-Based System
(KBS) were generated under NASA contract NAS3-25644 originating from the Office of
Advanced Concepts and Technology and administered through NASA-Lewis Research Center.
The support of the Program Manager, Anita Liang, and the advice and direction of the

Technical Monitor, Robert Hendricks, are gratefully appreciated. Major contributors to code
development were:

Dr. Bharat Aggarwal: KBS and OS/2 PC conversion of labyrinth seal code KTK
Dr. Antonio Artiles: cylindrical and face seal codes ICYL and IFACE
Dr. Mahesh Athavale and Dr. Andrzej Przekwas: CFD code SCISEAL

Mr. Wilbur Shapiro: gas cylindrical and face seal codes GCYLT, GFACE, and seal
dynamics code DYSEAL

Dr. Jed Walowit: spiral groove gas and liquid cylindrical and féce seal codes SPIRALG
and SPIRALL

The labyrinth seal code, KTK, was developed by Allison Gas Turbine Division of General
Motors Corporation for the Aero Propulsion Laboratory, Air Force Wright Aeronautical
Laboratories, Wright-Patterson Air Force Base, Ohio. It is included as part of the CFD
industrial codes package by the permission of the Air Force.
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1.0 SUMMARY

Advanced seals have been shown to result in significant enhancement of performance and life
of turbomachinery. Consequently, NASA embarked on a five-year program (Contract NAS3
25644) to provide the U.S. aerospace industry with computer codes that would facilitate
configuration selection and the design and application of advanced seals.

The program included four principal activities:

1. Development of SCISEAL, a scientific Computational Fluid Dynamics (CFD) code
capable of producing full three-dimensional flow field information for a variety of
cylindrical configurations. The code is used to enhance understanding of flow phenomena-
and mechanisms, to predict performance of complex situations, and to furnish accuracy
standards for the industrial codes. SCISEAL also has the unique capability to produce
stiffness and damping coefficients that are necessary for rotordynamic computations.

2. Generation of industrial codes for expeditious analysis, design, and optimization of
turbomachinery seals. The industrial codes consist of a series of separate, stand-alone
codes that were integrated by a Knowledge-Based System (KBS).

3. Production of a KBS that couples the industrial codes with a user-friendly Graphical User
Interface (GUI) that can in the future be integrated with an expert system to assist in seal
selection and data interpretation and provide design guidance.

4. Technology transfer via four multiday workshops at NASA facilities where the results of
the program were presented and information exchanged among suppliers and users of
advanced seals. A Peer Panel also met at the workshops to provide guidance and
suggestions to the program.

The program has produced a wealth of computer codes that provide a solid foundation for

analyzing and designing many of the advanced seals being contemplated for future air-breathing
and space propulsion engines.
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2.0 INTRODUCTION

NASA's advanced engine programs are aimed at progressively higher efficiencies, greater
reliability, and longer life. Recent studies indicate that significant engine performance advantages
and dramatic life extensions can be achieved through the use of advanced seals'. Advanced
seals control leakage and lubricant and coolant flow, prevent entrance of contamination, inhibit
the mixture of incompatible fluids, and assist in the control of rotor response.

Recognizing the importance and need of advanced seals, NASA, in 1990, embarked on a five-
year program (Contract NAS3-25644) to provide the U.S. aerospace industry with computer codes
that would facilitate configuration selection and the design and application of advanced seals.

The program included four principal activities:

I. Development of SCISEAL, a scientific Computational Fluid Dynamics (CFD) code
capable of producing full three-dimensional flow field information for a variety of
cylindrical configurations. The code is used to enhance understanding of flow phenomena
and mechanisms, to predict performance of complex situations, and to furnish accuracy
standards for the industrial codes. SCISEAL also has the unique capability to produce
stiffness and damping coefficients that are necessary for rotordynamic computations.

2. Generation of industrial codes for expeditious analysis, design, and optimization of
turbomachinery seals. The industrial codes consist of a series of separate, stand-alone
codes that were integrated by a Knowledge-Based System (KBS).

3. Production of a KBS that couples the industrial codes with a user-friendly Graphical User

Interface (GUI) that can be appended to an expert system to assist in seal selection and
data interpretation and provide design guidance.

4. Technology transfer via four multiday workshops at NASA facilities where the results of
the program were presented and information exchanged among suppliers and users of
advanced seals. A Peer Panel also met at the workshops to provide guidance and
suggestions to the program.

This final report has been divided into separate volumes, as follows:

Volume 1: Executive Summary and Description of Knowledge-Based System

Volume 2: Description of Gas Seal Codes GCYLT and GFACE

Volume 3: Description of Spiral-Groove Codes SPIRALG and SPIRALI

Volume 4: Description of Incompressible Seal Codes ICYL and IFACE

Volume 5: Description of Seal Dynamics Code DYSEAL and Labyrinth Seal Code KTK
Volume 6: Description of Scientific CFD Code SCISEAL.

This Executive Summary volume provides general conclusions and recommendations, summarizes
the codes, and describes the KBS that integrates the industrial codes by a user-friendly GUI.
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3.0 GENERAL CONCLUSIONS

The program has produced a wealth of computer codes that provide a solid foundation for
analyzing and designing many of the advanced seals being contemplated for future air-breathing
and space propulsion engines. Air-breathing applications include:

* Turbine rim seals

* Turbine blade tip seals

* Compressor end seals

» Interstage seals

* Thrust balancing devices.

Space propulsion engine applications include:

* Helium buffer seals

* Liquid oxygen seals

* Damping seals

» Hydrogen seals

* Parallel and helical grooved cylindrical seals.

Applications are not limited to advanced engines. The codes can also be used to design seals for
a variety of industrial machines such as boiler feed pumps and pipeline gas compressors.

The codes are designed to treat fluid-film seals, where a clearance exists between the rotating and
stationary components. Leakage is inhibited by surface roughness, small but stiff clearance films,
and viscous pumping devices, e.g., spiral grooves.

Since seals can introduce destabilizing influences to rotating shafts, which can result in significant
problems, most of the codes produce dynamic stiffness and damping coefficients for subsequent
insertion into rotordynamics analysis. Dynamic coefficients are determined not only by the

industrial codes, but also by the computational fluid dynamics (CFD) code SCISEAL, which is
the only known CFD code with this capability.
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4.0 RECOMMENDATIONS

The industrial codes were written for a PC environment using OS/2 as an operating system. At
the inception of the program, OS/2 appeared to be the logical extension of PC operating systems
and was jointly supported by Microsoft and IBM. The advantages of OS/2 were clear : a 32-bit
operating system as opposed to contemporary 16-bit systems; multi-tasking and multi-threading
capabilities; safeguards against system crashes; and a graphical environment. Indeed, OS/2 has
proven to be a very robust system, with excellent compilation capabilities and amenable to the
development of a user-friendly GUI that was accomplished for the industrial codes. Unfor-
tunately, the rupture between IBM and Microsoft has led to a proliferation of operating systems
for PCs (Windows 3.1, Windows 95, Windows NT, OS/2 Warp), with the Windows systems -
being a significant majority. The prevalence of Windows systems is expected to continue
because of preloading on new computers and external software production. Thus, wide dis-
semination of the codes, a principal objective, requires that the industrial codes be ported to the
Windows systems. The industrial source codes were written in Fortran 77 and can be compiled
on any operating system. Input for the original source codes is reasonably friendly in that

variable names are included. However, for intermittent users who are the majority, GUI is far
superior to Fortran input.

The scientific code SCISEAL is principally UNIX based, which is not a uniform operating
system, and it is hardware dependent. It was developed for a Silicon Graphics workstation;
variations have been compiled for Sun and Hewlett Packard.

To promote extensive code usage, which could lead to significant advances in seal technology,
it is recommended that the codes be ported to additional operating systems. In particular, the
industrial codes should be ported to Windows 95 and Windows NT, and the scientific code
should be ported to IBM AIX, and DEC Alpha workstations and to Windows NT.

Software expires unless maintained and continually updated, and, unfortunately, there are no
provisions for continuing this effort. Technical areas that could benefit by continuing this work
include counterrotating seals, high-pressure gas seals, compliant seals, and contact face seals.
Also, the present codes are very amenable to transition to fluid-film bearing technology, and all
the codes could be coupled to rotordynamics codes. SCISEAL, which is presently limited to
cylindrical seals, should be augmented to include face configurations.

It is therefore recommended that provisions be made to maintain and update the codes, and
add the additional routines required to advance the state of the art in seal technology,
bearing technology, and rotor bearing systems.
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5.0 CODE DESCRIPTIONS

The scientific and industrial codes developed under the program are briefly described below.

5.1 Scientific Code

SCISEAL (scientific seals, CFD code) was developed to provide detailed flow information for
a variety of existing and new types of turbomachinery seals. It is an advanced 3-D CFD code
for solutions of the Navier-Stokes (N-S) flow equations. A pressure-based solution methodology
is used to integrate the flow equations in a sequential manner. A variation of the SIMPLEC
method is used to impose the velocity-pressure coupling. The flow domain is discretized using
the finite-volume method, and a collocated variable arrangement is used to store the flow
variables. An implicit, multi-domain capability allows the division of complex flow domains into
suitable subdomains; this allows optimum use of computational cells, easier grid generation and
improved grid quality. The current capabilities and the numerical and physical models include:

* Steady and time-accurate solutions of incompressible and compressible flows
* High-order spatial (3rd) and temporal (2nd) discretization schemes

* A variety of turbulence models: standard and Low-Re k-€¢ models, and a two-layer model
for narrow seal passages and treatment of isotropic surface roughness

* Full range of boundary condition types, including seal specific conditions
* A moving grid algorithm for rotor tracking, variable fluid properties.

The code has two automated methods for calculating seal rotordynamic coefficients. For a nominally
centered seal, a whirling rotor method is available, which uses the full N-S equations on whirling
seals to generate the rotordynamic coefficients. For nominally eccentric seals, a small perturbation
method is available. The rotor is perturbed about its nominal position, and the N-S equations are
used to generate the equations for the perturbation variables. These are solved to yield the
perturbation rotor loads and the rotordynamic coefficients. Both of these methods are set to handle
cylindrical seals and similar geometries, and are available in the multi-domain mode.

5.2 Industrial Codes

GCYLT (gas, cylindrical, turbulent) analyzes a variety of cylindrical seals such as steps, tapers
and hydrostatic geometries. The code is a Reynolds equation solver that considers laminar and
turbulent flow in the film region. Principal usage is for low-clearance geometries that are
effective in inhibiting leakage, such as floating ring and circumferentially sectored seals. The
code produces the clearance and pressure distribution over a specified grid network, leakage along
specified flow paths, interface loads, righting moments, viscous dissipation and frequency
dependent stiffness and damping coefficients'”. Plotting routines are also provided for visualizing
the clearance and pressure distributions. Applications include seals for compressors, industrial
gas turbines, jet engines, and helium buffer seals for space turbomachinery.
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GFACE (gas face) attributes and capabilities are similar to those of GCYLT, but it was
developed in polar coordinates rather than cylindrical coordinates, and it is limited to laminar
flow. Plotting routines are also provided for visualizing the clearance and pressure distributions.
Applications include seals for compressors, gas turbines, and jet engines.

SPIRALG (spiral-groove gas) produces interface performance of spiral-groove cylindrical and
face seals. The flow is assumed to be laminar, and isothermal and narrow groove theory is used,
which characterizes the effects of grooves by a global pressure distribution without requiring
computations on a groove-by-groove basis. The code produces forces, moments, film thickness,
leakage, power loss and cross-coupled frequency-dependent stiffness and damping coefficients.
Spiral-groove seals are finding wide application in pipeline compressors, laser gas circulators and
computer disk drives, and they have also been developed for application to advanced air-breathing
and space propulsion turbomachinery. '

SPIRALI (Spiral-groove liquid (incompressible) seals) is based on the Hir's bulk flow model
with the addition of spiral groove theory. Turbulence is treated with an extended form of the Hir's
bulk flow model, generalized to include separate and arbitrary friction-factor Reynolds number
relationships for each surface. Narrow groove theory is used to characterize the spiral groove
geometries, which maintains the global representation. Geometries with film discontinuities such
as parallel and multiple helical grooves, employ loss coefficients. Rough surfaces can be
modeled by applying appropriate friction factor relationships. Output includes forces, moments,
film thickness, leakage, power loss and cross-coupled stiffness and damping coefficients. Per-
formance is confined to concentric operation. In addition to spiral-groove cylindrical and face
seals, this code can treat axisymmetric variations in geometry, such as tapers and barrel shapes.
Applications include spiral-groove seals, pressure breakdown bushings, wearing rings, damping
seals and parallel and helical groove seals for high-pressure pumps and cryogenic turbomachines.

ICYL (liquid (incompressible) cylindrical) capabilities include 2-D incompressible, isoviscous
turbulent flow in cylindrical geometries, rotation of rotor/and or housing, roughness of both rotor
and housing and inertia pressure drops at inlets to the fluid film from the ends of the seal and
from pressurized pockets. Inertia effects are incorporated by applying a Bernoulli relation at each
boundary point and reducing the static pressure by the computed kinetic energy. Couette and
Poiseuille turbulence and cavitation are included. Geometries such as steps, pockets, tapers,
preloaded arcs and hydrostatic recesses can be treated. The code produces the pressure and
clearance distributions, rotor position, forces and moments, pocket pressures and flows, and the
cross-coupled dynamic coefficients (stiffness and damping). Applications include liquid hydro-

static and hydrodynamic seals for pumps, cryogenic machines, and miscellaneous machinery.
Plotting routines are also provided.

IFACE (liquid (incompressible) face) has similar characteristics as ICYL, except it analyzes face
seal or thrust configurations rather than cylindrical configurations.

DYSEAL (dynamics of seals). The dynamic response of seal rings to rotor motions is an
important consideration in seal design. For contact seals, dynamic motions can impose significant
increases in interfacial forces, resulting in high wear and reduction in useful life. For fluid-film
seals, the rotor excursions are generally greater than the film thickness, and if the seal ring does
not track, contact and failure may occur. The computer code DYSEAL can determine the
tracking capability of fluid film seals and can be used for parametric variations in geometry to
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find acceptable configurations. For face seals, the code will determine response to rotor motions
in five degrees of freedom, which are the three translations and two rotations about the center of
gravity. The interface is represented by cross-coupled stiffness and damping coefficients that are
determined from other codes. The effects of Coulomb friction of the secondary seals on seal ring
response are included. Piston ring and O-ring secondary seals can be analyzed. The code can
also determine response of floating ring seals. The floating-ring model permits two degrees of
freedom for both the shaft and the ring, and is intended to determine seal ring response to an
orbiting shaft. The secondary seal occurs between the ring and the wall and x-y Coulomb friction
at that location is accounted for. The method of computation is a forward integration in time that
provides absolute motions in all degrees of freedom. At every time step, friction is evaluated to
determine whether motions continue or are halted.

KTK (knife-to-knife) calculates the leakage and pressure distribution through labyrinth seals based
on a detailed knife-to-knife analysis. Input data are required to describe in detail the seal
geometry and the environmental conditions affecting the leakage. Output is provided in the form
of leakage flow and flow resistance characteristics, i.e., flow factor versus pressure ratio. In
addition, an optimization feature is included which permits the user to identify global geometric
constraints and allows the code to predict an optimum seal configuration based on minimum
leakage. The labyrinth seal design model is an expansion of the knife-to-knife analyses reported
in the literature. Th such approaches, one-dimensional flow parameters in the knife throats are
computed and linked together by a total pressure loss calculation. Flow coefficients are used for
individual knives or groups of knives to account for the vena contracta in knife throats. Velocity
head carry-over from upstream knives is accounted for by reducing the head loss between knives
based on the flow expansion angle. The code basis used extensive empirical data produced by
the Allison Engine Company under Air Force sponsorship®.

User manuals® " were generated to describe the theoretical basis of the codes and the methods

to implement the FORTRAN versions.

NASA/CR—2004-213199/VOL1 11






6.0 DESCRIPTION OF KNOWLEDGE-BASED SYSTEM (KBS)

The function of the KBS is to provide user-friendly access to the industrial codes via pull down
menus and dialog boxes that contain check box and radial button alternatives. Although the KBS

is independent, perusal of the user manuals” " '¥ will facilitate understanding of the input and
output produced on the KBS.

6.1 System Executive

The CFD Executive Program integrates all components of the CFD industrial codes package. The
individual codes are accessed through the executive. In addition, the executive provides utility
functions such as browsing and printing output files created by the analysis programs, and plotting
the data output by some of the industrial codes. The main screen is shown on Figure 1. There is
a button for each of the seal categories for which codes are available. The individual codes are
accessed by first clicking on the appropriate seal category to bring up the menu of individual codes
in that category, and then clicking on a button to execute the desired code. Figure 2 shows the
options in the Bushing and Ring Seal category.

6.2 Description of Menus

The file menu provides facilities to browse, print, and delete data files generated by the analysis
codes. Figure 3 shows the File Selection Dialog used by all the programs to specify names of
files. The files in the current directory, and, when appropriate, the names of subdirectories are
listed in a listbox. To select a file name, you have to double click on a name in the file list box
to select the file and then press the ACCEPT button. You can switch directories for which the
files are listed in the file list box by double clicking on the directory name. When selecting a
file to browse or an input data file to read, you may only select file listed in the listbox. When
specifying the name of a file to be saved on disc, you may enter a name in the file name field
or select a name listed in the listbox. If the file you specify already exists, you will be asked to
confirm that you want to replace the existing file.

When the Browse File menu item is selected, the file selection dialog is displayed for you to
select the name of the output file to browse. The file you select is then displayed in the Browse
Dialog as shown in Figure 4. You can print the file being browsed by pressing the Print button.

The Help menu provides access to the on-line help. Context-sensitive help can also be accessed
by pressing the F1 key or a Help button if one is available.

The File menu is used to save input data in a file and read data from a previously saved input file.
Figure 5 shows the file menu selections available for each of the industrial codes. The input file
selection dialog is displayed for you to specify the name of the input data file to be read or saved.
Once the data has been read from a file, it can be changed using the normal input procedures. The
main screen for the program displays the descriptive title for the current data set.

NASA/CR—2004-213199/VOL1 13



The Help menu is used to access the help system. Context sensitive help is available at all times by
pressing the F1 key. Figure 6 shows the help menu selections available for each of the industrial
codes. The help index is available for assistance with a specific topic such as an input variable.

The Analysis menu is used to begin an analysis after input data has been prepared. Figure 7
shows the analysis menu selections available for each of the industrial codes. When the Run
Analysis menu item is selected, the file selection dialog is displayed for you to specify the name
of the output file(s) that will be generated by the analysis code. An existing name may be
selected from the file list, or a new name may be input at this time. If entering a new name, you
only need to enter an eight-character file name. The program supplies the appropriate
extension(s). The analytical program is then started as a separate process in its own window.
The message "Analysis in progress..." is displayed in the program's main window until the analysis
is completed. Once the analysis is running, the user interface is available for use. You may not,
however, start another analysis while a previous one is in progress. Status messages from the
analytical code that is running may be viewed by switching to the analytical-code window.

A batch mode which allows sequential execution of up to five test cases has been provided. When
the Batch Mode menu item in the analysis menu is selected, the screen shown in Figure 8 is
displayed to enter the input, output, and, if applicable, pressure file names for up to five cases. Only
the file names and extensions need to be entered. A listbox containing the available input and output
files is displayed at the bottom of the screen for viewing. The program will check to ensure that the
input files you supplied exist. The names of the pressure files may be required for GCYL, GFACE,

ICYL, and IFACE. The pressure files can be used as an initial guess of the pressure distribution to
enhance convergence and speed.

The View menu in each program is used to browse program input, program output, and, if
applicable, to plot data. Figure 9 shows the view menu selections available for each of the
industrial codes. You are restricted to browsing and plotting files in the output file directories

of the program you are using. The input view is based on current values entered by the user and
is displayed in the format used by the analysis code.

The Input menu is used to input data. The menu items are essentially the same for each program.
The input menu options for the GCYL code are shown in Figure 10. Selecting a menu item
brings up a screen with the relevant input fields. The displayed input screen may hide or disable
certain fields depending upon values that were entered on other input screens. The purpose of
the input screens for each of the menu items is described below using GCYL as an example.

Analysis Options are used to define the scope of the analysis to be performed, and to define the
title and units to be used for the input case. Figure 11 shows the Analysis Options screen with
default values. Mutually exclusion options such as Calculate Stiffness are shown as radio buttons
with the current choice highlighted. You can select only one of the options in a group of radio
buttons. Other options such as boundary conditions allow several elements to be selected at the
same time. These are shown as checkboxes. To get help on the choices available in an option,
select the option and press the F1 key. The help screen for the Calculate Stiffness option is
shown in Figure 12. The Analysis Options always contains an option to choose between SI and
English units. The units displayed in the field labels and the numeric values will be automatically
changed to the correct units. The SI and English units for frequently used quantities are as follows:
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Description SI Units English Units
Lengths m Of mm in.
Angular Velocity rev/min or rad/s rev/min or rad/s
Velocity m/s /s
Forces N Ib
Gas Constant ms¥°K in.”/s*°R
Temperature °K R
Density kg/m’ lbm/in.’
Viscosity Pa-s 1b-s/in.?
Pressure Pa psia or psig
Entropy IKgl°’K Btu/tbm/°R
Inertia Kg-m’ bm-ft’
Moments N-m in.-ib
Angles deg or rad deg or rad
Energy J ft-1b
Power W ft-1b/s
Stiffness N/m Ib/fin.

The Seal Geometry screen is used to specify seal dimensions as shown in Figure 13 with default
values. The values are entered in the entry fields. If a field is not needed because of the analysis
options selected, it is disabled to prevent you from entering data in that field.

The Operating Conditions screen is used to specify operating parameters such as speed,
temperature, eccentricity, and pressures as shown in Figure 14 with default values.

The Seal Configuration screens are used to specify special features such as fluid sources,
Rayleigh steps, spiral grooves, etc. These screens will, therefore, differ significantly from code
to code. Figure 15 shows the screen for specifying flow line coordinates in GCYL. A flow line
is a grid line with specified grid coordinate boundaries (X1, Y1) and (X2, Y2). The lines are
specified as an array of starting and ending grid coordinates for the lines. Four sets of values in
the array are displayed on the screen. You can scroll through the array using the scroll bar.
When the number of lines is entered in the entry field and the cursor is moved to one of the
fields in the array, the scroll bar will adjust its range to match the number of lines specified.

The Grid Definition screen used to define the grid used in the numerical solution is shown in
Figure 16 with variable grids turned on for both axial and circumferential grids. The default is
to turn off variable grids. The arrays used for variable grids are disabled if they are not required.

The Properties screen shown in Figure 17 is used to input seal fluid properties such as viscosity
and specific heat ratio.

The Solution Control screen shown in Figure 18 is used to input information such as tolerance
and number of iterations used to control the numeric solution.
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The Set Defaults option is used to set values in all the screens to system defaults for the program.

Plotting routines are available to plot clearance and pressure distributions and to plot dynamic
response for the dynamics code. Examples of film thickness and pressure plots are shown on
Figures 19 and 20.

Further elaboration on the use of the KBS is found in Reference!'!!,
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Figure 6. Help Menu in Industrial Codes
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Figure 7. Analysis Menu in Industrial Codes
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Figure 8. Batch Mode Analysis Input Screen
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Figure 9. View Menu in Industrial Codes
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Figure 10. Main Screen and Input Menus for GCYL
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Figure 11. Analysis Options Screen for GCYL
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You can elect to have the analysis include |
cross coupled, frequency dependent
stiffness calculations. The program
provides the option of determining
stiffnesses in two or four degrees of
freedom. Two degrees of freedom include
the x and y mode of the center of the
journal while four degrees of freedom
include the two orthogonal angular modes
about the mass center. The Default is not
to calulate stiffness.

" 95TR34-V1

Figure 12. Context Sensitive Help
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Figure 13. Seal Geometry Screen for GCYL
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Figure 14. Operating Conditions Screen for GCYL
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Figure 15. Seal Configuration Screen for GCYL
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Figure 16. Grid Definition Screen for GCYL
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Figure 17. Seal Fluid Properties Screen for GCYL
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Figure 18. Solution Control Screen for GCYL
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Figure 19. PLOT4DPM - Film Thickness Plot
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